Date:
November, 1999

From:
A. B. Schwarzkopf


aschwarz@ou.edu
Subj:
The Baby Sitter system.

The following modules will introduce you to Microsoft Visual as it is used to produce customer interfaces for online databases.  The modules will instruct you to build a Visual Basic interface to a database, in this case in MS Access.  VB has its own database management system, the MS Jet engine, but it is more common to connect VB to an external database in some other language.  The programming case assumes that the SBA has decided to implement a babysitting service as a fund raiser.  You are to write the information system to support that project.  The handout modules will walk you through some initial screens, but you will be asked to complete more.

You will work in groups.  Sharing of knowledge with anyone is expected, but the project you turn in should be generated by your group and the data in it should reflect your own work.  Copies of another group projects are not acceptable.  Expected deliveries are:

· Cover memo.

List the attachments that you are giving me.  Describe any unique features or experiments you tried that you want me to give you credit for.  Include the names of each group member that participated.

· Completed Database.

Create the Babysit database as described in Appendix 2a.  Add all of your group members as employees, and all MIS faculty as customers.  Include at least 10 jobs.

Complete the assignment at the end of the Appendix.

· Completed VB exercise.

Complete all modules of the handout.  Deliver the finished project for your group on a floppy disk, or by e-mail.  Provide a printed screen capture of each of the screens you created.

· An updated version of the handout.  

The handout was created as an introductory guide for beginning Visual Basic programming.  It was written in VB 4.0 to be an independent introduction to programming in visual basic.  Turn in a copy of the handout with hand written corrections and clarifications added as needed.

· Extended system.

Add two additional screens to the dialog generated by the handouts.  The additional screens should make sense in the context of the case.  That is the screens should do something useful.  Provide screen captures for each and include them in your project on disk.  The final product should include enhancements to the original system as well as the new screens.  The quality of this work will affect your grade.

· Dialog diagram.
We will discuss this in class.  The diagram indicates screen sequences, objects included on the screen and the actions possible from each object.

Grading Sheet for Babysitter VB project

Names:  ________________________________________________________________

Cover Memo










________ /  5

Database

· Correctly populated?










________ / 15

VB Exercise
· Modules 1 – 5

Is the code complete and correct?

Are there screen captures of the dialogs?

Is the code set up to run with full screed display and correct start?










________ / 40

· Module 6

Does the system work as needed?

Are the navigation menus and buttons complete?

Will the system update records?










________ / 20

Handout Correction

· Are the comments extensive and useful?










________ /  5

Extended System

· 2 Extra screens?

· Useful function?









________ / 10

Diagram

· Is there an attempt to diagram the system?










________ / 5

EXTRA










________ /









TOTAL
_________ / 100
Using Microsoft Visual Basic
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Objectives

This set of 6 modules is intended to help you use Microsoft Visual Basic to create a front end for a database access application.  The modules will walk you through a simple business oriented application under the assumption that you do not know Visual Basic. The modules will have you:

· Create a Visual Basic program

· Link the program to a database

· Populate the database using the Visual Basic program

· Write simple reports and extractions

Note: Throughout the tutorial we use the symbol  > to denote a left mouse button click.  Thus >> indicates a double-click on the lefty mouse key.

MODULE 1:  GETTING STARTED

In this module you will create a project and generate an interactive screen using Visual Basic.

Starting a VB Project
Changing Caption and Name Properties on a Project
Adding a Toolbox and Objects to a Form
Saving Your Work
Running the Program
Exit Button
Attaching Code to Objects

Starting a Visual Basic Project

Visual basic projects consist of an executable module, forms, indexes and other files, which are saved individually to a folder.  It is a good idea to create a separate folder for each project to keep these together.

Create a folder called Babysit.  Select the Programs option under the Start Menu: 

>>Microsoft Visual Studio 6.0.

>>Microsoft Visual Basic 6.0

(If your installation has not been modified, you will see a New Project menu.  Select Standard.EXE to start VB.  Otherwise you will open in a new project automatically)

This starts the VB program.  You are in a new project window with a default name (Project 1 in a new installation.)  To change the name and storage location of the new project 

> File 

> Save Form As...frmExp.frm  (The form has to be saved first before the project can be saved)

> This will open a window labeled “Save Project As”.  

> Navigate to the folder you created (in the CBA labs it will be on your A drive)

> OK.  Save the project as Exp.vbp 

>OK.

This set of commands saves a form called frmExp.frm and an executable module called Exp.vbp in the folder you created.  As you create different objects such as the form above, Visual Basic programming conventions suggest that you name them with a prefix (frm) that describes what kind of object they are and an extension (Exp) that defines what they do.  Each word in the extension is capitalized and spaces are not used.

Changing Caption and Name Properties
Now you have a blank form on the screen with the toolbar at the top of the screen.  Move your cursor anywhere inside Form1 and right click the mouse.  > Properties or go to the properties window on the right side of the screen.  This is where you can change the appearance or function of objects.  For Form1 we want to change the Caption and the Name properties. 

· Find the Name property.  Replace “Form1” with “frmExp”.

· Use the up and down arrows to the right of the properties window until you find the Caption property.   Delete “Form1” and replace it with  “Experimental Program”. The form now has “Experimental Program” at the top.

Adding the Toolbox and Objects to the Form
Now we are ready to add some objects to the form.  We need the Toolbox, which contains all the objects we use.  VB normally starts with the toolbox visible on the left side of the screen.  If it is not visible, add the Toolbox by > view > Toolbox.  If you drag the pointer to each icon on the toolbox, VB will give you a description of what that object is.  We are going to work with option buttons and a label.

Add an option button to frmExp.  To do this, >> on the option button icon in the Toolbox.  This creates an option button object called Option 1 in the center of the form.  An object can be moved by holding down the left mouse button and moving the cursor.  This is called DRAGGING.  You can also change an object’s size by > inside the object, placing the cursor on any of the outlining dots until the cursor changes from one arrow to two ((), and then holding down the left mouse button and moving the cursor to change the object size.  Try dragging the option button object to the left side.  

Now let’s look at the properties of the option button.  Make sure it is SELECTED by > inside it so that it is outlined by dots. You can view the properties window the same way you did for the form or you can > the properties icon on the Toolbar at the top of the screen.  Again we need to change its Caption and Name. 

· Change the Caption to “Good Morning”.  

· Change the Name to “optGoodMorning”.  

· Also, change the color of the words.  > on ForeColor property.  > ( (the triangle on the right of the properties line).  Select the Palette by > the tab at the top of the window that appears and choose a green color. The option object may need to be stretched to fit all of “Good Morning” in it.  

Now create two more option button objects.  Their captions should be “Good Afternoon “ in red and “Good Evening” in yellow.  Their  names should be “optGoodAfternoon” and “optGoodEvining”.  Arrange the objects to the left side of the form.

Now we need a label object.  Select the label icon and do the same thing with it as with the option button objects.  Enlarge the label object.  Now look at its properties.  Change the Alignment to “2-Center”.  Change the Caption to “Good Morning” and the Name to “lblMessage”.  Change the ForeColor to blue and font to size 24.

Saving Your Work
Periodically you will want to save your work to save yourself from having to repeat steps.  To save you can go to the file option on the menu bar and select ‘save’ or you can use the mouse to > on the save icon on the Toolbar.

Running the Program
We can now run our program.  Save the current changes to the program.  Move the mouse to the ‘run’ icon on the tool bar and > the run icon.  You can click on any of the option buttons.  You will notice that only one will be active at a time.  Stop your program by > the stop icon (blue square next to the run icon).

Attaching Code to the Objects

The way VB causes an object to perform an action is by attaching code to it.  This code will be executed when the program user performs an action (called an EVENT) such as a mouse click or mouse movement.

Exit Button
You want to have an Exit button on the form to stop the program.  This will require creating a button and attaching code to it.  To do this select a command button object.  Drag it to the bottom left of the form.  Change the Caption to “E&xit”.  The “&” underlines the next character (in this case the “x”).  This allows the user to access the object by pressing Alt + x or by clicking on it.  Change the Name to “cmdExit

Now we need to attach code to the command button. >> on the cmdExit object.  This brings up the code window.  You will notice the object is cmdExit and the Proc (procedure) is Click.  Insert the word “End” in between the two lines of code already provided for you.  The result will look like:

Private sub cmdExit_Click( )

End

End Sub

Close the code window and run the program.  > the cmdExit object.  Your program should terminate.

Each object has its own subroutines.  When an object receives an action, such as a click, it runs that subroutine.  In this case, when we clicked on the cmdExit object it ran its sub_click routine, which told the computer to end the program by executing the Visual Basic instruction END.  

Option Buttons

Now let’s build subroutines for each of the option button objects.  >> on optGoodEvening.  Enter the following code the same way you did for cmdExit:

lblMessage.Caption = “Good Evening”

This time you need to use the quotation marks.  Run your program.  > on optGoodEvening.  The lblMessage should read “Good Evening”.  Exit the program.  Now add code to optGoodMorning and optGoodAfternoon.  Run the program to make sure it works.

Note:  The instruction you inserted into the option buttons illustrates the way visual basic manages the properties of its objects.  The “lblMessage” component of the command identifies the object;  the “Caption” component after the period identifies the property line from the properties window for that object.  The text “Good Evening” after the equal sign replaces whatever text was originally inserted as the default in the window.

Note:  Notice that when you run the program above, the “Good Morning” option button is active (black).  When you first display a form, VB gives “focus” to objects on the form in the order in which they were inserted onto the form.  Since we inserted the “Good Morning” option button first, it starts with focus.  Focus order is determined by the “TabIndex” property.  To change the way this form works, >> the cmdExit object and change its TabIndex value to 0.  Run the program.  The Exit button should have focus when the form opens. 

MODULE 2- VIEWING DATABASE TABLES

In this section you will write a Visual Basic program that displays the contents of a MS Access database table.  You need the Baby-Sitter database created in MS Access.  If the Baby Sitter database is not already available to you, you should follow the instructions in Appendix 2a to create and populate it. Adding FlexGrid and Data Control Objects
Adding FlexGrid and Data Control Objects

Start VB.  Create a new project called Babysit with a form called frmViewData in it.

· > File

· > New Project. 

· > File

· > Save Project As...  Save the form as frmViewData.frm and the project as Babysit.vbp.  

Now we are ready to add a FlexGrid control object to the form.  The FlexGrid control displays a database table during runtime (i.e. when the program runs).  If the FlexGrid icon is not on the Toolbox you need to add it.

Adding a FlexGrid icon to the VB toolbar:

· Move the cursor to the Toolbox on the left of the screen and click the RIGHT mouse button.  

· Select the Components option on the window that drops down.  This will open a menu of additional objects that you can add to the VB screen.  Select the controls tab (at the top) to display a menu of additional controls for the Toolbox.

· Scroll down to the line marked “Microsoft FlexGrid Control 6.0” and > on the checkbox next to it.

· >OK.  VB should add a new FlexGrid icon to the toolbox.  

We need to insert a Data object onto the form.  This object has special properties that tie into databases. Now look at the Data object’s properties. 

· Change the Name to “datBaby”.  

· Change the DatabaseName to the baby-sit database.  When you > the continuation box (with three dots in it) VB will open a navigation window.  Navigate to the database and > open.  VB will insert the path to it in the properties box.

· Change the RecordSource to “CUSTOMER”.  

· Change Visible to “False”.  

· Delete Caption

Insert the FlexGrid object into your form and enlarge it.  Select FlexGrid (it should already be selected).  

· Change DataSource to datBaby.  If you click the drop-down arrow, VB will list the data sources available on the form.  Select datBaby.

Now run the program.  The customer table should be visible.  The three option buttons and the Exit button should be visible but the datBaby object should not be visible.  Save and exit the program.

The option button captions and names need to change to the tables' names in the Baby-sit database.  Change them to “Customer”, “Employee”, and “Job”.  the form’s caption and name should be changed.  

Change the Caption to “Baby-sit Program” and the Name to “frmBaby”.

Now we need to change the code.  Insert the following code into the optCustomer object:

datBaby.RecordSource = “CUSTOMER”

datBaby.Refresh
Do the same for the optEmployee and optJob objects (remember the tables’ names are in caps so we need to write EMPLOYEE  and JOB in caps also).

Run the program.  Click on each option button and make sure the FlexGrid displays the correct table.  Exit the program.

Add a label above the FlexGrid to identify which table is being displayed.  Also change the FlexGrid so that it does not show the CUSTOMER table until the option button is pressed.

Note:  A Data object always forms the connection between the database and VB objects.  VB connects the Data object to the database and connects the displays to the Data object.

Note:  You can manage the properties table either through the properties boxes or through VB code.  The properties box is the default; VB code scripts are not executed until their event occurs.

Appendix 2a
CREATING ACCESS DATABASES November. 1999

A.B. Schwarzkopf, Andrea Bond

Creating a Database

The SBA Baby-sitting Service

The Student Business Association wants to start a baby-sitting service to operate as a fund-raiser for projects.  To do this the SBA recruits students who volunteer to be sitters.  After they go through training the students indicate the nights they are normally available to work and are added to the EMPLOYEE table in the database.  When customers call in to the service, the Coordinator checks to see if their name is in the CUSTOMER table and enters it if not.  The Coordinator then checks to see who is available for the date requested and assigns the job.

The student design team created a database to support this problem that consisted of three tables:  EMPLOYEE, CUSTOMER, and JOB.  The E-R diagram for the solution looks like this.




EMPLOYEE



CUSTOMER








  JOB

The attribute detail for these tables looks like


EMPLOYEE
Attribute
Type
Length
Index
Format


EmployeeNumber
Number
Long Integer
Yes/No duplications

Key

EmployeeLast
Text
20




EmployeeFirst
Text
15




EmployeeAddress
Text
30




EmployeeCity
Text
20




EmployeePhone
Text
12




Monday
Y/N





Tuesday
Y/N





Wednesday
Y/N





Thursday
Y/N





Friday
Y/N





Saturday
Y/N





Sunday
Y/N






CUSTOMER
Attribute
Type
Length
Index
Format


CustomerNumber
Number
Long Integer
Yes/Unique

Key

CustomerLast
Text
20




CustomerFirst
Text
15




CustomerAddress
Text
30




CustomerCity
Text
20




CustomerPhone
Text
12





JOB
Attribute
Type
Length
Index
Format


JobNumber
AutoNumber
Long Integer
Yes/Unique

Key

Date
Date/Time


mm/dd/yy


EmployeeNumber
Number
Long Integer


FK

CustomerNumber
Number
Long Integer


FK

TimeBegin
Text
8




TimeEnd
Text
8




Using Microsoft ACCESS:

 The BABY-SIT Database
Objectives

Use Microsoft ACCESS to create a database

· Create Tables 

· Link Tables together into a database

· Populate Tables with data

Note:  The symbol > denotes a mouse click.  Thus >> means double-click the mouse.

Creating a Table
a.
Name the database.  In the Program Manager of Windows >> Microsoft Office >> Access.  > File > New.  Name the database “Babysit.mdb”.  > OK.  Now there is a window that reads “Babysit:Database”.  In the CBA labs be sure the database is created on the A: drive.

b.  
Create the CUSTOMER Table.  > New > New Table.  There should be a window which reads “Table1: Table”.  It also has 3 columns:  “Field Name”, “Data Type”, and “Description”.  We will design our customer table first. Enter the following field Names (note: the data type for these in the Table above).



CustomerNumber



CustomerLast



CustomerFirst



CustomerAddress



CustomerCity



CustomerPhone

The descriptions should be easy.  However, CustomerNumber is a primary key which is number representing the customer.  You may want to add that to the description.  The descriptions are an excellent opportunity to provide internal documentation.  You should add them at this time.

Relational database tables should  have a primary key, or identifier attribute, field to sort their information by.  No primary keys can repeat.  Because customers may have the same first and last names (i.e. two Bob Smith’s) we included our CustomerNumber field.  Click the cursor on the far left gray box of the CustomerNumber line.  Then > key icon at the top of the screen.

Note:  When you create the primary key this way, ACCESS automatically generates a unique index on the key field.  This is how ACCESS guarantees uniqueness of the key values.

Now save your work by > Save icon (looks like a floppy disk).  Name the table “CUSTOMER”.  > OK. Close the window by > X sign in the top left of that window (not the Microsoft Access window at the very top of the screen).

c.
Add the EMPLOYEE Table.  > New > New Table.  this will be our EMPLOYEE table.  Once again all of the data types are “Text”.  Enter the following field names:



EmployeeNumber-number field



EmployeeLast



EmployeeFirst



EmployeeAddress



EmployeeCity



EmployeePhone



Monday



Tuesday



Wednesday



Thursday



Friday



Saturday



Sunday

EmployeeNumber is a 3-digit number which uniquely identifies the employee.  For the days of the week, it will be a Yes/No field.  Make the EmployeeNumber the key and save the table as “EMPLOYEE” and close the window.  

Note:  Move your cursor to the type property field  for ‘Monday’ on the design view for the EMPLOYEE table and click on it.  You should see a drop down box.  One of the options in the box is Yes/No.  Change the type property to this choice for the weekday attributes.
d.  
Create the JOB Table.  Start a new table.  Enter the following field names:

JobNumber

(Data Type = AutoNumber.  Generates sequential integers)

Date 


(Data Type = Data/Time, format = shortdate. Enter the






example of the short date in the description)

EmployeeNumber  
(Data Type = Text)

CustomerNumber

TimeBegin  

(Data Type = Date/Time, format = Medium time.  Enter the






example of the short date in the description).

TimeEnd  

(same as TimeBegin)

We are using the JOB table to link the CUSTOMER and EMPLOYEE tables together by matching EmployeeNumber and CustomerNumber in two tables.  Since one employee can sit for a given customer several times, we generate an artificial attribute in the table called JobNumber.  Make JobNumber the primary key for this table by highlighting it and clicking the key icon on the toolbar.

To create foreign keys, hold down the control button while using the mouse to select each of the fields that will be keys.  Then select key icon.

Note:  ACCESS will permit you to create a table without a primary key.  If you do not specify one and try to save the table, ACCESS will ask if you want it to create a primary key.  If you respond with ‘No’ then it will create the table without a primary key.  (If you respond ‘Yes’, ACCESS will add a new attribute that is type AutoNumber for the key.)
e. 
Connecting Tables.  We need to connect the three Tables so that there is a way to determine which employee will sit for a specific customer on a specific date.  First  > on the Relationships icon on the Toolbar. ACCESS will display a set of boxes for each table.  You create links between tables by dragging the mouse from a key in one table to a corresponding key in the other.  We want the CustomerNumber in the CUSTOMER table to relate to the CustomerNumber in the JOB table.  Create this relationship by placing the mouse on the  CustomerNumber in the CUSTOMER table  and holding down the left mouse button move the cursor to the CustomerNumber in the JOB table.  Release the left mouse button.  A Relationships window pops up.  Check the box next to “Enforce Referential Integrity”.  Make sure it is a one to many relationship.  >"Create".  Do the same thing with EmployeeNumber.  Start with the EmployeeNumber from the EMPLOYEE table and drag your cursor to the EmployeeNumber in the JOB table.  Now all of your tables are joined.

f.
Displaying Results.   Do this after you enter data.You can display the data in a single table directly from the table view.  You can print the results by pressing (>) the print icon or by using the print options from the File Menu item just like you print results from any other Windows application.  Printing results from multiple tables has to be done from the Query option on the ACCESS Master Menu.  Return to the Master Menu by closing the table view from the File Menu Option on the Menu Bar.  Switch to the Query option.  Select New, and use the New Query option (you can play with the Wizard if you want but this is simple).  Add each of the three tables you created and close the Add Tables window.  ACCESS will create a version of the Relationships diagram that you generated in (e).  You will select the attributes you want to display in the table that is displayed below the diagram.

Note:  ACCESS (actually this is an SQL convention) names attributes with a two level name separated by a dot.  Thus EMPLOYEE.CustomerNumber is the CustomerNumber in the EMPLOYEE Table.

· Move the mouse cursor to the top line of the first column and click (>).  You will see a drop down table with all of the attribute names in the entire data view for the query.  Choose CustomerLast.

Note:  the * option selects all  of the attributes from the specified table.

· Drop down to the next box and click (>).  Choosing an option in this box specifies the sort order for the output display.  Choose ascending.

· Drop down to the next box and activate the check box.  If you don’t activate the box, the attribute is available but not displayed.
· Skip the other boxes in the column.   These are used to specify partial selections and groupings.  You can experiment with these later.
· Move to the next columns to select and display EMPLOYEE.EmployeeLast, JOB.beginDate, and JOB.end.

Print the results of the query with the print icon or the Print option from the File item on the menu bar.

Assignment. Create your own data.
Add data to all tables.  

· Add all members of your group + 4 Accounting faculty to the EMPLOYEE table 

· Add all MIS faculty to the CUSTOMER table

· Create 10 different entries in the JOB table.  You can make up the dates. 

1.
Print the contents of each table separately.

2.
Print the Relationship Diagram.  

In Relationships, Click on Tools, Add-Ins, Print Relationships.  This opens a window that places the relationship diagram on a page with a title and data displayed at the top.  Then click on File, Print to print out diagram
MODULE 3-  ENHANCING THE BABYSIT PROGRAM

What we want to see is an interesting opening screen followed by our frmBaby form.  We need a picture.  Start MS PAINT from the Accessories menu in the program manager.  Create a picture and save it as Baby.bmp to your disk.  Exit paintbrush and start VB.  Open the Baby program.

Note:  VB will use any picture in a standard format (bmp, jpeg, gif, etc.) if you have one.

Inserting Another Form

We need to insert another form into our project.  To add the form  > Project > Add Form.  Look at the form’s properties.  

· Change the Name to “frmStart”.

· Change the Caption to “Baby-Sit Program”.  

· Change the Picture to the picture you created.  Enlarge or shrink the form to fit the picture.

· Save the form as “frmStart.frm”.  (> File,  >Save frmStart.frm As, enter the form name as frmStart, >OK)

Using Timer Object to Switch Between Forms

We need a way for our program to go to our frmBaby form automatically.  We will use the Timer object to do this.  Insert a timer object into the form from the toolbox.  Look at its properties.  

· Set the Interval to 5000 ( or 5 seconds.  VB counts in milliseconds)

· View the code window for the Timer object.  Insert the following code:

frmBaby.Show

Unload frmStart
This changes the display to frmBaby and then unloads the frmStart.  When a project is run it loads all the forms.  We won’t need to see frmStart again so we unload it to speed up the program.

Changing the Initial Form Selection

We need to alter the order in which forms appear so that frmStart displays first.  If we ran the program now frmBaby would show first.  To do this

· > Project 
· > Baby Properties and select the General tab.
· Go to the Startup Object window and press the down arrow to open the dropdown window.  Select frmStart as the Startup form.
· > OK.  
Now run the program.  The frmStart should be displayed.  Notice the timer object is not visible.  In approximately 5 seconds the program should display frmBaby.  Save and exit the program.
MODULE 4-  MODIFYING DATA IN A SINGLE TABLE

In this module we will create a form that will allow us to display and manipulate data from a single table.  We want to create a form to modify customer data in our database.  

To do this add a new form to the project(> Project > Add Form).

· Change the Caption to “New Customers”

· Change the Name to “frmCustomer”.

· Add 6 Textboxes to hold all the fields of the CUSTOMER table.  We will also need 6 labels.  Arrange the labels and text boxes as shown:

Number

Last Name

First Name 

Phone Number

Address

City
Now change the properties of the labels.  Their Captions should be the same as above example of their arrangement.  The Names should be the same, with “lbl” before the name and no spaces.  Also, change the Font Color to green.

Note:  You can simplify this task by using a SINGLE click on the object on the toolbox to highlight it, then drawing a box on the form with the mouse with the left mouse key depressed.  When you release the mouse key, VB will place the object into the box.  Also, once you have one Label and one Textbox placed where you want them, you can use the mouse to draw a box around BOTH objects.  VB will activate the handles (little boxes) on both of them together.  If you then > Edit >Copy, and again > Edit > Paste VB will place both objects on the form (you can also use the Copy and Paste icons).  VB will tell you that you already have objects with the same name and ask if you want to create a control array;  > NO.  You can then move the objects to where you want them.  If you first set properties such as DataSource on an object, the copied object will retain them.

Next add a Data object to the form.  

· Change its Name to “datCustomer”,

· Change its Caption to “CUSTOMER”,

· Change the  DatabaseName to the Babysit database,

· Change the RecordSource to “CUSTOMER”.

Tying Textboxes to the Database

The textboxes should also be named the same as their corresponding labels except for “txt” before the name.  There are other changes we need to make.  We want the textboxes to read in information straight from the database.  

· Change Name to correspond with the label

· Change the DataSource to “datCustomer”

· Change DataField to the corresponding field name

· Delete the Text.

We want to see if our form works so far.  For test purposes we want to start with this form so change the startup form in the > Project > Babysit Properties > Startup Object to frmCustomer.  Run the program.  The Textboxes should display the contents of one of the records in the CUSTOMER database.  Use the arrows of the datCustomer control object to scroll through all the records in the CUSTOMER table.  Notice how the arrows on the end take you to the first and last record while the arrows in the middle move one record at a time.  Stop the program.

Note:  It is valuable to debug each screen as you go.  The more you isolate the places that could cause errors, the easier a program is to debug.

Adding and Deleting Records

We can also add or delete customers on this form.  Add 2 command buttons, name one “cmdAdd” and the other “cmdDelete”.  Change the Captions to “&Add” and “&Delete”.  Position the buttons at the bottom of the form.

Add the following code to the cmdDelete object:

datCustomer.Recordset.Delete

datCustomer.Recordset.MoveNext
The “Delete” command will delete the current record.  The “MoveNext” command moves to the next record.  Without this command you would only see blank textboxes after you deleted the record.  In MS Access you must move to another record in order for your changes to be saved to the database.  The “MoveNext” moves to the next record and  commits the delete to the database.

Next add the following code to the cmdAdd object:

datCustomer.Recordset.AddNew

The “AddNew” command adds a new record at the end of the table.  All of the entries are blank until you enter the new contents into the Textboxes.  To commit the new data to the database we need to move to another record after the user enters all the information into the Textboxes.  We can either expect the user to click an arrow on the datCustomer object or we can create another button.
Insert another command button into your form and change the Caption to “&OK” and the Name to “cmdOK”.  Add the following code:

datCustomer.Recordset.MovePrevious

datCustomer.Recordset.MoveLast

This moves to the previous record, committing the new record, and then moves to the new record (remember the new record was inserted after the last existing record so it is now the last record).  Move the cmdOK object next to txtCity.  After the user enters all the information he/she can click on the cmdOK.  Now run the program and experiment with adding and deleting records.  > Stop.

When the user goes to enter a new customer they will want to use the next highest customer number.  It would be nice to have the last record showing when we switch to the form rather than the first one.  Get to the code window of the form by >> anywhere inside it.  Change the Proc to “Initialize”.  Insert the following code:

datCustomer.Recordset.MoveLast

Now run the program.  Notice that the last record is displayed.  > Stop.

Note:  This form was created for data entry.  Any changes the user makes to the database will be permanently saved (once the user moves off the changed record).  If you DO NOT want to permit changes, change the ReadOnly property on the datCustomer object to “True”.  This would prevent changes.  Of course you could not add or delete records either.

MODULE 5- NAVIGATING AMONG SCREENS

Previously we had our program open with our bitmap image and in 5 seconds go to our form with the FlexGrid which displayed our tables.  There were no choices.  Now we have 2 forms we want to access.  We are going to add another form and use it to make a choice among several options:

one choice will show the new customer form we just created (frmCustomer), 

one choice will show the table we created earlier (frmBaby), and 

one choice will exit the program.

Navigating to a New Form Using Command Buttons

Insert another form.  Name it frmIntro and set its Caption to “Selection Menu  Insert 3 CommandButton objects onto the form to select what we can do.  For the object that will show the new customer form we will want to unload frmIntro and then display the new customer form.  

· Change the Name to cmdModCustomer

· Change the Caption to “Modify Customer Database”

· Insert the following VB code behind the button:

Unload frmIntro

frmCustomer.Show
Use the same format with the CommandButton that will show frmBaby.  Use the “End” command for the object that will terminate the program.  Change the TabIndex property value on the “End” command to 0.

When you are inserting several options like this with similar code behind each one you can copy and paste the VB script from one object to another.  To create the code behind the button that shows frmBaby you can open the code screen and copy the commands from the previous button with standard MS cut and paste operations.

Check your code by resetting the Startup Object to frmIntro and running it.

Now we need to change the coding of frmStart so it will display frmIntro on the screen after the timer finishes.  Go to frmStart and change the code of the Timer to display the correct form.  Reset the Startup Object and test your code.

When you tested the program above, the only way you could try all of the options on frmIntro was to restart the program and pick another choice.  Users will not be comfortable with this.  We need to be able to get back to frmIntro from the other forms.  Start with frmBaby.  You already have a command button on this form to exit the program.  We will modify this to return to frmIntro.  Click on cmdExit.

· Move the button to the lower right hand side of the form.

· Change the Name to cmdReturn

· Change the Caption to &Return

· Open the Code window and insert the commands

frmIntro.Show

Unload frmBaby

· Notice that the code for the cmdExit button is still present in the window.  Delete all of the code for that button including the break line:

Private Sub frmExit_Click()

End

End Sub

Next open frmCustomer and insert a new command button on it.  Place this button on the lower right hand corner of the form and configure it the way you did the Return button on frmBaby.  Test your code.  The program should return to frmIntro after visiting either of the other forms.

Note:  You could also have used option buttons for this form.

Note:  As a matter of good form design it is usually preferable to exit a program from only one screen as we did here.  This prevents a user from accidentally losing partially completed work by hitting the wrong button.  It also allows the designer to write graceful exit routines in only one place.  

Note:  Utility functions such as the Return button should appear in the same place on every screen.

Creating a Menu

A MENU in Microsoft terminology is a bar with words on it similar to the one at the very top of the VB editor screen.  When you select one of the words on the menu, a dropdown box of choices appears for you to select from.  

We could also use a menu entry on frmBaby to get back to frmIntro.  We will use the Menu Editor to create one.  Although you can access the Menu Editor as an option under Tools, we will use the icon.

· > Menu editor icon.  

· Type in “&File” in the Caption box.

· Type in “mnuFile” in the Name box. 

·  > Next. 

· Type in “&Main Menu” in the Caption box.

· Type in “mnuMainMenu” in the Name. 

·  > the right arrow.  This moves the “&Main Menu” over to the right. 

·  > OK.

When you look at frmBaby now there should be the word “File” on the menu bar.  If you > on the word File, a box appears with the words Main Menu and Exit in it  With the box still showing >> mnuMainMenu object.  The code view for the mnuMainMenu objects opens up.  Insert  the code that will unload frmBaby and show frmIntro.  This code is the same as the code behind the cmdReturn button.  

Modify frmCustomer in a similar way.  Save and test your code.

Note:  An easy way to insert the code into the mnu object is to copy and paste it from the corresponding cmd action objects on the form.

Note:  It has become customary to provide the same choices on the menu as on the screen and to set the menu up so that it can be operated from the keyboard without using the mouse.

MODULE 6- APPOINTMENTS FORM ( WITH SQL)

This module will show you how to use VB to manipulate tables in an external database.  The language used to manipulate relational databases is called SQL (Structured Query Language) and is typically covered in a database course.  We will use SQL statements in the discussion below, but an explanation of SQL syntax is beyond the scope of this module.

We want to make a form that will automatically update our database with newly created jobs.  In other words, every time a customer calls for a baby-sitter the computer user will pull up that customer’s name, enter the date the customer needs a baby-sitter for, and show the available baby-sitters.  Finally, when all the information has been checked, a confirmation button adds the information to the job table.

There are a number of ways to write this program.  We have chosen to use SQL coding within VB to show how database code and VB interact.

This module has 3 parts:

6A:  DROP-DOWN LIST BOXES, 

6B  DATE/DAY AND EMPLOYEE SELECTION

6c  ADDING INFORMATION TO THE JOB TABLE
MODULE 6A  USING DROP-DOWN LIST BOXES

We will create a form that will display the id number for a customer or employee we have entered into the system.  One useful way to do this is to allow users to browse through a drop down box to pick the individual they want to know about. These are not simple combo boxes.

Create a new form:

· Change the caption to “Appointments” and the name to “frmAppt”.  

· Insert 2 DBCombo objects and 2 Data objects.  If the DBCombo icon does not appear on your Toolbox you may add it by checking Microsoft Data Bound List Controls 6.0.  (Right click somewhere on the Toolbox, > Components, > Control Tab, check Data Bound List Controls, > OK). 

· Name the DBCombo objects “cboEmployee” and “cboCustomer”.  Name the Data objects “datEmployee” and “datCustomer”.

· Change the ReadOnly property to True on both Data objects.  This prevents accidental changes to the database.  

· Tie the Data objects the baby-sitting database and their respective tables.  Make them invisible.

· Change the DataSource on the cboEmployee control object to datEmployee.  Change the DataField EmployeeLast.

· Change the RowSource on the cboEmployee control object to datEmployee and the ListField to EmployeeLast.  

· Use the same approach for the cboCustomer object.

Save your results.  Run your program.  Make sure you change the Startup Form to frmAppt.  Click on the  ( next to each DBCombo object.  They should show a drop-down menu of a list of people you can choose from.  > on a name.  The drop down box closes and the name you selected is in the textbox.  Stop the program.

Note:  The DataSource and DataField determine the display in the original single box.  The RowSource and ListField determine the contents of the dropdown box.  When you enter the RowSource the BoundColumn is also set.  It is helpful to look at the properties of a DBCombo object by clicking the “Categorized” tab at the top of the Properties display to group the properties by function.

Note:  DBCombo controls should be used with Read Only access.  The DBCombo control changes objects.  It is intended to allow the user to select a value from the drop down list and insert that value into the current record in the table.  Unless the ReadOnly property on the Data control is set to “True”, changes typed into the combo field will change the database.  In fact a double click on one of the entries in the drop down box will also change it.

We also want to know the Customer and Employee Numbers for customers and employees we select in the ComboBoxes.  To do this we need to add 2 TextBox objects and 2 more Data objects.  

· Change the Name the TextBox objects to “txtCustNumb” and “txtEmpNumb”.

· Change the DataField value of txtCustNumb to “CustomerNumber”.

· Change the DataField value of txtEmpNumb to “EmployeeNumber”.

· Change the Name of the Data objects “datCustNumb” and “datEmpNumb”.

· Tie the Data objects to the database and tie the TextBox objects to their respective Data objects.

· Make the data objects invisible

SQL Statements

We will use an SQL statement to display the Customer Number of the customer we pick on the cboCustomer object.  There are other ways to do this, but this will introduce the use of SQL with VB to manipulate a data interface.

We will put the SQL code under the Click event behind the ComboBoxes on the form.  The number will be updated whenever someone clicks on the object.  They will click on it to select a customer which in turn updates the number.  Insert the following code in the cboCustomer object in the Click procedure:

datCustNumb.RecordSource=“SELECT * FROM CUSTOMER WHERE CustomerLast = ‘” & cboCustomer.Text & “’;” 

datCustNumb.Refresh
The first two lines together make up the SELECT statement.  They should be typed on the same line of the VB Code window.  New lines in VB code indicate new statements.
The “SELECT * FROM CUSTOMER” selects everything from the customer table.  “WHERE CustomerLast = ‘ “ & ...  selects everything that falls under those conditions.  Because the customer’s name is a string, or text (instead of numbers) SQL requires it to be in single quotes.  However, since we are using an object’s text we need to end the SQL statement with double quotes, use the “&” sign to tell VB there is more, state the object (cboCustomer.Text), use another “&” sign, start SQL again with double quotes to get the second single quote in for our string.  The semicolon marks the end on an SQL statement.  We want the datCustNumb to display the number to do this we use the Refresh method. Now use this technique for the cboEmployee.  The SELECT statement should read:

“SELECT * FROM EMPLOYEE WHERE EmployeeLast= ‘” &cboEmployee.Text & “ ‘ ;”

Save your code and run the program.  Watch the numbers change each time you select a different person .  Notice that the numbers do not appear until you click on an entry in the box because the code is attached to the “click” event in the code window.

Adding New Customers

This form works fine as long as you don’t enter a new customer.  But since adding customers is the key to growing businesses, we need a way to enter a new customer quickly.  We want to create a way to go to frmCustomer and back to frmAppt.  Create a CommandButton to show frmCustomer. Name the command button cmdModCust.  Do not unload frmAppt since we will be going back to it after we enter the customer information.  A good Caption may be “Add New Customer”.  Users can get back to the Appt form by closing frmCustomer with the default MS close-form “x” icon in the upper right corner of the form.

When you run the program and return to frmAppt, the cboCustomer drop-down box will not contain the customer you just created.  You will need to use the Refresh method which updates the datCustomer.  Insert the following code into the GotFocus procedure of the cboCustomer:

datCustomer.Refresh

This will refresh the datCustomer when the cboCustomer has focus.  It will have focus from the first time you click on it until you click on another object.  The reason the code was NOT put into the Click procedure is that in the Click procedure, every time you clicked the box it would Refresh the cboCustomer and display the first customer record again.

Note:  The Refresh statement above can go on many objects and be associated with several events.  This flexibility can make VB script hard to debug.  It becomes important to develop consistent shop standards for where to put common operations.

We are going to access frmCustomer from the Appointments screen, so we should change the project navigation sequence to access frmCustomer from frmAppointment rather than from frmIntro.  

· Change the cmdModCustomer Caption to “Add New Customer”

· Change the coding to display frmCustomer

· On frmIntro change the Caption of cmdModCustomer to “Make New Appointment”

· Change the code to show frmAppointment rather than frmCustomer

· It would also be a good idea to change the name of cmdModCustomer to cmdMakeAppointment.  If you do this, the code subroutines will not be updated automatically.  You will also have to change the names of the objects on the subroutines manually.
Change the Startup Object back to frmStart.  Save and test the program.

MODULE 6B  DATE/DAY AND EMPLOYEE SELECTION

Currently, frmAppt allows a user to determine ID numbers for either customers or employees based on their last name and to transfer to frmCustomer to add a new customer.  It does not yet allow the user to accept a babysitting job request or assign an employee to a job.  We are going to insert code into frmAppointment to allow the Program Manager to identify employees who are available for a particular date.  We will assume that the Manager first types in the job information on a new job record, then assigns employees.

Before starting this module it might be a good idea to include some labels to mark what each object is.  for instance you could put the cboCustomer and the txtCustNumb together and put a label with the word “Customer” over both objects.

We will need 2 TextBoxes to display the date and day for a potential job.  Name the TextBoxes “txtDate” and “txtDay”.  We will want the txtDate to hold the date typed in by the user.  You may want to have an example date in your label so the user will know how to enter it.

Now insert a command button into the form. This will allow us to display the day in our txtDay and it will allow the cboEmployee to display only those Employees who are available for that day of the week and do not already have a job that day.

We’ll start with converting the date from txtDate and displaying the corresponding day in txtDay.  Insert the following code in the click procedure of the command button you created:

txtDay.Text = Format$(txtDate.Text,”dddd”)

Now run the program.  Enter a date using the format (6/14/94) in txtDate and > the command button.  The txtDay should display the day of the week your date refers to.  Exit.

Now we will enter the rest of the code for the cboEmployee list.  Insert the following code after the code for the txtDay:

datEmployee.RecordSource = “SELECT EmployeeLast FROM EMPLOYEE WHERE ” & txtDay.Text & “ = Yes” & “ AND EmployeeNumber NOT IN (SELECT Employee Number FROM JOB WHERE (JOB.Date = #” & txtDate.Text & “#))”

datEmployee.Refresh
This SQL is more complicated than we want to explain for a Visual Basic introduction.  You will cover this syntax in a database course.  However, the code selects records from the EMPLOYEE table for which the value of the day the employee marked available (Yes) matches the day in txtDay and the employee does not already have a job on the date in txtDate.  The reason why “txtDay.Text” and txtDate.Text didn’t require single quotes is that their values are translated as part of the SQL code and not as the value of a alphanumeric attribute.

Save the program and test the code.  After you select a date, look at the cboEmployee drop-down box.  The list should be limited to those people available on that day.  If you have the JOB table populated (i.e. have records in it) try entering a date that is already in the JOB table.  Notice that the employees scheduled for that day do not show up in the cboEmployee drop-down box.  Exit.

MODULE 6C  ADDING INFORMATION TO THE JOB TABLE
We are ready to add code to put a new record to the JOB table to record a valid babysitting appointment.  It will work the same way as the new customer form works.

Refer to the attribute list for the JOB table.  JobNumber is automatically generated, Date, EmployeeNumber and CustomerNumber are values in controls on frmAppointment  We need to include the final fields needed in the JOB table:  TimeBegin and TimeEnd.  Use 2 textboxes and label them.

Now we need to display the record.  It is displayed on the screen but we need to see what is actually in the JOB table, just like the new customer form.  Add 5 more text boxes to the form and a Data object.  Tie the Data object to the JOB table and name it “datJob”.  Now tie all the textboxes to datJob with the RecordSource as:

txtNewDate

Date

txtEmplNumber
EmployeeNumber

txtCustomerNumber
CustomerNumber

TxtBeginUtility

TxtEndUtility and tie these to the database.

Add another command button to the form;  call it cmdConfirm. This will be the confirmation button, or the button that adds the information to the database.  Because none of the other textboxes or DBCombo boxes are tied into the JOB table it can’t be updated.  However, by copying the information into the 5 new textboxes that are tied into the JOB table we can add records to the JOB table.  Insert the following code into the confirmation button:

datJob.Recordset.AddNew

Still in the code for cmdConfirm set the Text properties of each of the new textboxes.  For example:

txtNewDate.Text       = txtDate.Text

txt BeginUtility.Text = txtBeginTime.text

txt EndUtility.Text   = txt EndTime.Text

Use similar code to do this for all 5 fields.  Then use the following code to save it in the table:

datJob.Recordset.MovePrevious

datJob.Recordset.MoveLast

datJob.Refresh
Let’s add one more thing: a DBGrid Control so we can view our JOB table and make extra sure our record has been recorded to the database.  Insert it onto the form and link it to the datJob.

Save the program and run it.  Enter information onto the frmAppt and > the confirmation button.  Notice the 5 new textboxes contain the information and the last record in the DBGrid is the record you just created.  Exit.

For a finishing touch you can add a way to get back to frmIntro.
